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	 3	 Create Simple Forms
In this chapter, you will learn how to
✔	 Create forms by using the Form tool.
✔	 Change the look of forms.
✔	 Change the arrangement of forms.

A database that contains the day-to-day records of an active company is useful only if it is 
kept current and if the information stored in it can be found quickly. Although Microsoft 
Access 2010 is fairly easy to use, entering, editing, and retrieving information in Datasheet 
view is not a task you would want to assign to someone who’s not familiar with Access. Not 
only would these tasks be tedious and inefficient, but working in Datasheet view leaves far 
too much room for error, especially if details of complex transactions have to be entered 
into several related tables. The solution to this problem is to create and use forms.

A form is an organized and formatted view of some or all of the fields from one or more 
tables. Forms work interactively with the tables in a database. You use controls in the form 
to enter new information, to edit or remove existing information, or to locate information. 
The controls you will use most frequently in an Access form are:

●	 Text box controls  You can view or enter information in these controls. Think of a text 
box control as a little window through which you can insert data into the corresponding 
field of the related table or view information that is already in that field.

●	 Label controls  These tell you the type of information you are looking at in the 
corresponding text box control, or what you are expected to enter in the text box 
control.

Tip  An Access form can also include a variety of other controls, such as list boxes, that transform 
the form into something very much like a Windows dialog box or wizard page. For information, 
see “Restricting Data to Values in Lists” in Chapter 6, “Maintain Data Integrity.”
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In this chapter, you’ll discover how easy it is to create forms to view and enter information. 
You’ll also modify forms to suit your needs by changing their appearance and the arrange-
ment of their controls.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter03 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Creating Forms by Using the Form Tool
Before you begin creating a form, you need to know the following:

●	 Which table the form should be based on

●	 How the form will be used

After making these decisions, you can create a form in the following ways:

●	 By clicking the table you want in the Navigation bar, and then clicking the Form but-
ton in the Forms group on the Create tab. This method creates a simple form that 
uses all the fields in the table.

●	 By using a wizard. This method enables you to choose which of the table's fields 
you want to use in the form.

See Also  For information about using wizards to create forms, see “Modifying Forms 
Created by Using a Wizard” in Chapter 7, “Create Custom Forms.”

●	 Manually in Layout view where you can see the underlying data or Design view 
where you have more control over form elements.

See Also  For information about manipulating forms in Layout view, see the other two 
topics in this chapter. For information about manually creating forms in Design view, 
see “Adding Controls” in Chapter 7, “Create Custom Forms.”

Tip  When creating forms for a Web database, you must use Layout view. You can use 
Layout view or Design view for non-Web databases.

You will usually want to start the process of creating forms that are based on tables by 
using the Form tool or a wizard—not because the manual process is especially difficult, 
but because it is simply more efficient to have the tool or a wizard create the basic form 
for you and then refine that form manually.

In this exercise, you’ll use the Form tool to create a form based on a table. You will then 
enter a couple of records by using the new form and refresh the table to reflect the 
new entries.
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SET UP  You need the GardenCompany03_start database located in your Chapter03 
practice file folder to complete this exercise. Open the GardenCompany03_start 
database, and save it as GardenCompany03. Then follow the steps.

Important  The practice file for this exercise contains tables that look similar to those in the 
practice file for Chapter 1. However, to simplify the steps, we have removed the relationships 
between the tables. Be sure to use the practice database for each chapter rather than continuing 
on with the database from an earlier chapter.

	 1.	 In the Navigation pane, display All Access Objects, and then in the Tables group, 
double-click Customers.

The Customers table opens in Datasheet view.

The record navigation bar shows that there are 108 records in this table.

Notice the CustomerID field, which contains a unique identifier for each customer and 
is the primary key field. In this case, the unique identifier is not an auto-generated 
number, but the first three letters of the customer’s last name combined with the first 
two letters of his or her first name.

See Also  For more information about this type of primary key, see “Restricting Data to 
Values in Other Tables” in Chapter 6, “Maintain Data Integrity.”

	 2.	 On the Create tab, in the Forms group, click the Form button.
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Access creates a simple form based on the active table and displays the form in 
Layout view. In this view, you can make adjustments to the layout and content of 
the form by clicking the buttons on three Form Layout Tools contextual tabs.

Tip  You don’t have to open a table to create a form based on it. You can simply click the 
table in the Navigation pane to select it and then click the Form button in the Forms 
group on the Create tab. But it is sometimes useful to have the table open behind the 
form so that you can verify the form contents against the table contents.

The first record in the table, displayed in Layout view.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

The Form tool has configured all the field names in the table as labels and all the 
fields as text boxes. In the header at the top of the form, the name of the table 
appears as a title, and the form icon appears as a placeholder for a logo.

	 3.	 Move the mouse pointer over the form, and click any label or text box control.

In Layout view, you can adjust the controls on the form, so any control you click 
becomes selected, ready for manipulation.
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	 4.	 On the View Shortcuts toolbar, click the Form View button. Then move the 
mouse pointer over the form, and click the City label.

In Form view, the Form Layout Tools contextual tabs are no longer displayed. 
Clicking a label doesn’t select the label for manipulation; instead it selects the 
entry in the adjacent text box, ready for editing. 

The first record, displayed in Form view.

	 5.	 In the record navigation bar at the bottom of the form, click the Next Record 
button.

Access displays the second record in the table.

	 6.	 Use the record navigation bar to display a few more records.

Tip  You can easily compare the information shown in the form to that in the table by 
alternately clicking the Customers table tab and the Customers form tab to switch back 
and forth between their pages.

	 7.	 At the right end of the record navigation bar, click the New (Blank) Record 
button.

Access displays a blank Customers form, ready for you to enter information for a 
new customer.
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The record navigation bar shows that this will be record number 109.

	 8.	 Click the CustomerID label.

The text box to the right now contains the cursor.

	 9.	 Type ASHCH, and press Tab.

When you start typing, the icon that indicates a record is receiving data (two dots 
and a pencil) appears in the bar to the left. When you press Tab or Enter, the cursor 
moves to the next text box.

	 10.	 Type the following information, pressing the Tab key to move to the next text box.

FirstName	 Chris

LastName	 Ashton

Address	 89 Cedar Way

City	 Redmond

Region	 WA

PostalCode	 88052

Country	 USA

PhoneNumber	 (425) 555-0191

	 11.	 When you finish entering the phone number, press Enter.
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Because you just typed the last field value in the record, Access displays another 
blank record. The record navigation bar now shows that this will be the 110th 
record in the table.

	 12.	 Type the following information, pressing the Tab key to move from text box to 
text box.

CustomerID	 BERJO

FirstName	 Jo

LastName	 Berry

Address	 407 Sunny Way

City	 Kirkland

Region	 WA

PostalCode	 88053

Country	 USA

PhoneNumber	 (425) 555-0187

	 13.	 When you finish entering the phone number, press Enter. Then in the record 
navigation bar, click the Previous Record button.

Access cancels the new record and displays the record you just created.

The information you entered for record number 110.
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	 14.	 Click the Customers table tab, and on the record navigation bar, click the Last 
Record button.

The two records you entered in the form do not appear at the bottom of the 
table, and the record navigator bar indicates that there are only 108 records in 
the table.

	 15.	 On the Home tab, in the Records group, click the Refresh All button.

Access synchronizes the form data input with the table, updates the record navigator 
bar to show 110 records, and displays the top of the table.

The two new records now appear in alphabetical order based on their CustomerID field 
values.

	 16.	 Close the Customers table.

	 17.	 On the Quick Access Toolbar, click the Save button. Then in the Save As dialog 
box, click OK to accept Customers as the form name.

Access saves the form. The Forms group appears on the Navigation bar, listing 
Customers as the only form in the database.

CLEAN UP  Close the form. Retain the GardenCompany03 database for use in later 
exercises.
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Changing the Look of Forms
When you create a form by using the Form tool, as you did in the previous exercise, the 
form includes every field in the table on which it is based. Each field is represented on 
the form by a text box control and its associated label control. The form is linked, or 
bound, to the table, and each text box is bound to its corresponding field. The table is 
called the record source, and the field is called the control source.

Forms and their controls have properties that determine how they behave and look. 
A form inherits some of its properties from the table on which it is based. For example, 
each text box name on the form reflects the corresponding field name in the source 
table. The text box label also reflects the field name, unless the field has been assigned 
a Caption property, in which case it reflects the caption. The width of each text box is 
determined by the Field Size property in the table.

Even though a form is bound to its table, the properties of the form are not bound to 
the table’s properties. After you have created the form, you can change the properties 
of the form’s fields independently of those in the table. You might want to change these 
properties to improve the form’s appearance—for example, you can change the font, 
font size, alignment, fill color, and border.

One of the quickest ways to change the look of a form is to change the theme applied 
to the database. A theme is a combination of colors and fonts that controls the look of 
certain objects. In the case of a form, it controls the color and text of the header at the 
top of the form and the text of the labels and text boxes. By default, the Office theme is 
applied to all databases based on the Blank Database template and their objects, but 
you can easily change the theme by clicking the Themes button in the Themes group 
on the Design contextual tab, and then making a selection from the Themes gallery. 
While the gallery is displayed, you can point to a theme to display a live preview of 
how the active database object will look with that theme’s colors and fonts applied.

If you like the colors of one theme and the fonts of another, you can mix and match 
theme elements. First apply the theme that most closely resembles the look you want, 
and then in the Themes group, change the colors by clicking the Colors button or the 
fonts by clicking the Fonts button.

Tip  If you create a combination of colors and fonts that you would like to be able to use with 
other databases, you can save the combination as a new theme by clicking Save Current Theme 
at the bottom of the Themes gallery.
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If you like most of the formatting of a theme but you want to fine-tune some elements, 
you can do so in Layout view. In this view, you can see the records from the table to which 
the form is bound, so when you make adjustments, you can see the impact on the data. 
(Changes to the data can be made only in Form view.) You might also want to add your 
organization’s logo or a small graphic that represents the form’s contents.

In this exercise, you’ll change the form properties that control its colors and text attributes. 
You’ll also add a logo to the form.

SET UP  You need the GardenCompany03 database you worked with in the preceding 
exercise and the Logo graphic located in your Chapter03 practice file folder to complete 
this exercise. Open the GardenCompany03 database, and then follow the steps.

	 1.	 In the Navigation pane, under Forms, right-click Customers, and then click 
Layout View.

The Customers form opens in Layout view.

	 2.	 On the Design contextual tab, in the Themes group, click the Themes button.

The Themes gallery appears.

Each thumbnail represents a theme. By default, the Office theme is applied to this database.

	 3.	 Point to each thumbnail in turn, pausing to see its name in the ScreenTip that 
appears and the live preview of the form header and text.
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	 4.	 Click the Austin thumbnail to apply that theme.

	 5.	 On the Design tab, in the Header/Footer group, click the Logo button.

	 6.	 With the contents of your Chapter03 practice file folder displayed in the Insert 
Picture dialog box, double-click the Logo picture.

The logo replaces the form icon to the left of the title in the form header.

The form now has a custom logo.

Now let’s experiment with individual properties.

	 7.	 On the Customers form, click the CustomerID label (not its text box).

The label is surrounded by a thick orange border.

	 8.	 On the Format contextual tab, in the Font group, click the Font Size arrow, and 
then in the list, click 8.

The label text is now significantly smaller.

	 9.	 Click the CustomerID text box (not its label), and then on the Design contextual 
tab, in the Tools group, click the Property Sheet button.

Keyboard Shortcut  Press Alt+Enter to display the Property Sheet.

See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at 
the end of this book.
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The Property Sheet for this form opens and displays the properties for the object 
whose name appears in the text box at the top of the pane. Above the box, the type 
of object is identified. The properties are organized below the box on four pages: 
Format, Data, Event, and Other. You can display all the properties on one page by 
clicking the All tab.

The Data properties of the CustomerID text box control.

Tip  Don’t change the properties on the Data page until you know more about controls 
and their sources.

	 10.	 In the Property Sheet, click the Format tab.

All the commands available in the Font group on the Format tab of the ribbon 
(plus a few more) are available on this page of the Property Sheet.
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The Format properties for the CustomerID text box control.

	 11.	 On the Format page, click Font Size, click the arrow to the right of the adjacent 
property, and in the list, click 8.

	 12.	 Set the Font Weight property to Bold.

On the form, the entry in the CustomerID text box reflects your changes.

Tip  Sometimes the Property Sheet might obscure your view of the controls on the form. 
You can change the width of the Property Sheet or of any task pane by dragging its left 
border to the left or right. You can undock the Property Sheet from the edge of the 
window and move it elsewhere by dragging its title bar. Double-click the title bar to 
dock it again.

	 13.	 At the right end of the box at the top of the Property Sheet, click the arrow, and 
then in the object list, click Label3.

The FirstName label is now selected. You can display the properties of any object 
on the form, including the form itself, by clicking the object you want in the  
object list.
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	 14.	 Repeat step 11 to change the font size of the FirstName label to 8 points.

You have now made changes to three controls on this form.

You have applied character formatting to the CustomerID label and text box control, and to 
the FirstName label.

These different ways of selecting a control and changing its properties provide some 
flexibility and convenience, but it would be a tedious way to make changes to several 
controls in a form. The next two steps provide a faster method.

	 15.	 In the upper-left corner of the dotted frame surrounding all the controls on the 
form, click the Select All button.

All the controls within the dotted frame are now surrounded by thick orange 
borders to indicate that they are selected. In the Property Sheet, the selection 
type is Multiple selection, and the box below is blank. Only the Format settings 
that are the same for all the selected controls are displayed. Because the changes 
you made in the previous steps are not shared by all the selected controls, the 
Font Size and Font Weight settings are now blank.
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	 16.	 Repeat steps 11 and 12 to set the Font Size and Font Weight properties of the 
selected controls to 8 and Bold.

	 17.	 With the controls still selected, set the Back Style property to Normal.

Although you can’t see any change, the background of the labels is no longer 
transparent.

	 18.	 Click the Back Color property, and then click the Ellipsis button at the right 
end of the property.

This Ellipsis button has different names and serves different purposes for different 
properties. In this case, clicking the Ellipsis button displays a color palette.

The colors in this palette reflect the color scheme that is part of the Austin theme.

	 19.	 Under Theme Colors in the palette, click the third box (Light Green, Background 2).

The background of all the controls changes to light green.

Tip  If the Back Color palette doesn’t include a color you want to use, click More 
Colors at the bottom of the gallery, select a color on the Standard or Custom page of 
the Colors dialog box, and then click OK to set the color and add it to the list of recent 
colors at the bottom of the gallery.

	 20.	 Set the Special Effect property to Shadowed, and the Border Color property to 
the fifth box under Theme Colors in the color palette (Green, Accent 1).
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	 21.	 In the form, click away from the selected controls to release the selection.

You can now see the results.

Applying a color and shadow to the labels and text boxes makes them stand out.

	 22.	 In the form, click the FirstName label. Then in the Property Sheet, click the 
Caption property, change FirstName: to First Name, and press Enter.

	 23.	 Repeat step 22 to change LastName to Last Name and  PhoneNumber to 
Phone.

Tip  Changing the Caption property of the form does not affect the Caption property of 
the table.

	 24.	 On the Quick Access Toolbar, click the Save button to save the design of the 
Customers form, and then close it.

The Property Sheet attached to the form also closes.

CLEAN UP  Retain the GardenCompany03 database for use in the last exercise.
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Changing the Arrangement of Forms
Forms generated with the Form tool are functional, not fancy. By default, they are arranged 
in the Stacked layout, which arranges all the label controls in a single column on the left 
and all their corresponding text box controls in a single column to their right. All the boxes 
of each type are the same size, and in the boxes, the text is left-aligned.

If it suits the needs of your data better to display records in a tabular layout much 
like that of a table in Datasheet view, you can click Tabular in the Table group on the 
Arrange contextual tab.

See Also  For more information about layouts, see the sidebar “Layouts” in Chapter 9, 
“Create Custom Reports.”

If the default layout doesn’t suit your needs or preferences, you can customize it. Most of 
the rearranging you are likely to want to do can be accomplished in Layout view, where 
you can see the impact on the underlying data. If you want to make more extensive 
changes to the layout of a non-Web database, you can switch to Design view.

See Also  For information about customizing forms in Design view, see Chapter 7, “Create 
Custom Forms.”

In Layout view, you can do the following to improve the form’s layout and make it 
attractive and easy to use:

●	 Add and delete a variety of controls

●	 Change the size, color, and effects of controls

●	 Move controls

●	 Change text alignment

●	 Change control margins

Tip  The order in which you make changes can have an impact on the results. If you don’t 
see the expected results, click the Undo button on the Quick Access Toolbar to reverse your 
previous action, or click the Undo arrow, and click an action in the list to reverse more than 
one action.

In this exercise, you’ll size, align, and rearrange the label and text box controls in  
a form.
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SET UP  You need the GardenCompany03 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany03 database, and then 
follow the steps.

	 1.	 In the Navigation pane, under Forms, right-click Customers, and click Layout 
View.

Because the Property Sheet was open when you last closed the form, it opens with 
the form.

	 2.	 Click the CustomerID label (not its text box), and on the Arrange contextual tab, 
in the Rows & Columns group, click the Select Column button.

Tip  You can also point above the selected control, and when the pointer changes to a 
single downward-pointing arrow, click to select the column of controls.

	 3.	 With all the labels selected, on the Format page of the Property Sheet, set the 
Text Align property to Right.

All the labels are right-aligned in their boxes. The Property Sheet indicates that by 
default, the Width property of the labels is 1.0611".

You can efficiently adjust the alignment of multiple controls by changing the Text Align 
property in the Property Sheet.
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	 4.	 Point to the right border of the CustomerID label, and when the pointer changes 
to a two-headed horizontal arrow, drag to the left until CustomerID just fits in 
its box.

	 5.	 In the Property Sheet, adjust the Width property to 0.8", and press Enter.

Tip  It is often easier to adjust the size of controls visually and then fine-tune them in 
the Property Sheet than it is to guess what property settings might work.

	 6.	 Select the CustomerID text box (not its label), and change its Width property 
to 1.5".

Tip  Throughout this book, we refer to measurements in inches. If your computer is set 
to display measurements in centimeters, substitute the equivalent metric measurement. 
As long as you are entering the default units, you don’t have to specify the unit type.

The width of all the text box controls is adjusted, not just that of the CustomerID 
text box. 

In a Stacked layout, all the controls in each column are the same width.

Notice that the controls are different heights. We’ll fix that next.
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	 7.	 Above the upper-left corner of the dotted border that surrounds all the controls, 
click the Select All button to select all the controls within the border. Then in the 
Property Sheet, set the Height property to 0.25".

	 8.	 On the Arrange contextual tab, in the Position group, click the Control Margins 
button, and then click Narrow.

Now all the controls are the same height and width and have the same interior 
margins.

You can control not only the size of the controls but also the distance from the control’s  
border to its text.

	 9.	 Click the Phone label (not its text box), and on the Arrange contextual tab, in the 
Rows & Columns group, click the Select Row button.

Tip  You can also point to the left of the selected control, and when the pointer changes 
to a single right-pointing arrow, click to select the row of controls.

9780735626928_book.indb   96 2/15/11   1:28 PM



	 Changing the Arrangement of Forms    97

	 10.	 Point anywhere in the selection, and drag upward, releasing the mouse button 
when the insertion line sits below the Last Name label or text box.

The Phone label and text box move to their new location. As you can see, it is 
easy to move controls within the structure of the Stacked layout. But suppose  
you want to rearrange the form so that some controls are side by side instead  
of stacked.

	 11.	 Point to the selected label and text box, and try to drag it to the right of the Last 
Name controls above.

The controls will not move out of their columns. They are confined by the Stacked 
layout applied to the form. To make more extensive layout adjustments, you need 
to remove the layout from the form.

	 12.	 Above the upper-left corner of the dotted border, click the Select All button. Then 
right-click the selection, click Layout, and click Remove Layout.

The dotted border disappears, and the form is no longer constrained by the 
Stacked layout.

	 13.	 Click the Last Name label, and then press the Delete key.

	 14.	 Click the LastName text box, point to the A in Ackerman, and when the pointer 
is shaped like a four-headed arrow, drag up and to the right until the pointer sits 
slightly to the right of the FirstName text box.

When you release the mouse button, the control snaps to an invisible grid that 
helps maintain consistent spacing on the form.

	 15.	 In the Property Sheet, adjust the Left property to 2.7".

	 16.	 Hold down the Shift key, and click the two adjacent controls to add them to the 
selection. Then top-align the controls by setting the Top property to 0.6".

	 17.	 Click the First Name label, and change the label’s Caption property to Name.

	 18.	 Rearrange the remaining controls in logical groupings on the form, and then close 
the Property Sheet.

We adjusted the position of the phone controls and then grouped and sized the 
address controls.
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In Layout view, this kind of arrangement can be achieved only if you remove the default 
layout, which constrains the controls in columns.

Tip  If you rearrange controls or add new controls to a form and then find that pressing 
Tab jumps around erratically instead of sequentially from one control to the next, you 
can change the tab order. When working in Layout view, you click the Other tab in the 
Property Sheet and set the Tab Index property for each control in the tab order you 
want. When working in Design view, you click the Tab Order button in the Tools group 
on the Design tab to display the Tab Order dialog box, where you can drag fields into 
the correct order. For more information about working with forms in Design view, see 
Chapter 7, “Create Custom Forms.”

	 19.	 Close the Customers form, clicking Yes when prompted to save its layout.

CLEAN UP  Close the GardenCompany03 database.
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Key Points
●	 The quickest way to create a form that includes all the fields from one table is 

by using the Form tool. You can then use the form to view and enter records.

●	 A form that is based on a table is bound to that form. The table is called the 
record source.

●	 By default, the form displays one text box control and its associated label control 
for each field in the table.

●	 Each text box control is bound to its field, which is called the control source.

●	 Each control has several properties that you can change in Layout view or 
Design view to improve the look and layout of the form.
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	 4	 Display Data
In this chapter, you will learn how to
✔	 Sort information in tables.
✔	 Filter information in tables.
✔	 Filter information by using forms.
✔	 Locate information that matches multiple criteria.

A database is a repository for information. It might contain only a few records or thousands 
of records, stored in one table or multiple tables. No matter how much information a data-
base contains, it is useful only if you can locate the information you need when you need it. 
In a small database, you can find information simply by scrolling through a table until you 
find what you are looking for. But as a database grows in size and complexity, locating and 
analyzing information becomes more difficult.

Microsoft Access 2010 provides a variety of tools you can use to organize the display of 
information stored in a database. For example, you can organize all the records in a table 
by quickly sorting it based on any field or combination of fields. You can also filter the 
table so that information containing a combination of characters is displayed or excluded 
from the display.

In this chapter, you’ll first sort information in a table based on one and two columns. Then 
you’ll explore three ways to filter tables and forms to display only the records that meet 
specific criteria.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice file you’ll use to complete the 
exercises in this chapter is in the Chapter04 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Sorting Information in Tables
You can sort the information stored in a table based on the values in one or more fields, in 
either ascending or descending order. For example, you could sort customer information 
alphabetically by last name and then by first name. This would result in the order found 
in telephone books.

Last Name	 First Name

Smith	 Brian

Smith	 Denise

Smith	 Jeff

Taylor	 Daniel

Taylor	 Maurice

Sorting a table groups all entries of one type together, which can be useful. For example, 
to qualify for a discount on postage, you might want to group customer records by postal 
code before printing mailing labels.

Access can sort by more than one field, but it always sorts sequentially from left to right. 
You can sort by the first field, and if the second field you want to sort by is to the right 
of the first, you can then add the next field to the sort. If you want to sort by more than 
one field in one operation, the fields must be adjacent, and they must be arranged in 
the order in which you want to sort them.

See Also  For information about moving fields, see “Manipulating Table Columns and Rows” in 
Chapter 2, “Create Databases and Simple Tables.”

Tip  You can sort records while viewing them in a form. Click the field on which you want to 
base the sort, and then click the Sort command you want. You can’t sort by multiple fields at 
the same time in Form view, but you can sort by one field and then the next to achieve the 
same results.

In this exercise, you’ll sort records first by one field, and then by multiple fields.

SET UP  You need the GardenCompany04_start database located in your Chapter04 
practice file folder to complete this exercise. Open the GardenCompany04_start 
database, and save it as GardenCompany04. Then follow the steps.

	 1.	 With All Access Objects displayed in the Navigation pane, under Tables, double-
click Customers.

The Customers table opens in Datasheet view.

	 2.	 Click the arrow to the right of the Region field name.

A list of sorting and filtering options appears.
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The list at the bottom includes check boxes for every unique value in the field.

	 3.	 Click Sort A to Z.

Access rearranges the records in alphabetical order by region.

The upward-pointing arrow at the right end of the Region field name indicates that the table 
is sorted in ascending order on this field.
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	 4.	 To reverse the sort order by using a different method, on the Home tab, in the 
Sort & Filter group, click the Descending button.

The sort order reverses. The records for customers living in Washington (WA) are 
now at the top of the list, and the arrow at the right end of the field name is pointing 
downward. 

In both sorts, the region was sorted alphabetically, but the City field was left in a 
seemingly random order. Suppose you want to see the records arranged by city 
within each region. You can do this by sorting the City field and then sorting the 
Region field.

	 5.	 Click the arrow to the right of the City field name, and then click Sort A to Z.

Access sorts the records alphabetically by city.

	 6.	 To finish the process, right-click anywhere in the Region column, and then click 
Sort A to Z.

The two fields are now sorted so that the cities are listed in ascending order within 
each region.

Both the City and Region field names have upward-pointing arrows.

	 7.	 On the Home tab, in the Sort & Filter group, click the Remove Sort button to 
clear the sort from both fields.
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The table reverts to the previously saved sort order. Now let’s sort both columns 
at the same time.

	 8.	 Click the City field name, hold down the Shift key, and click the Region field name. 
Then in the Sort & Filter group, click the Ascending button.

Because the City field is to the left of the Region field, Access cannot achieve the 
result you want.

The City sort is overriding the Region sort.

	 9.	 Clear the sort, and then click away from the City and Region fields to clear the 
selection.

	 10.	 Click the Region field name, and drag the field name to the left of the City field 
name, releasing the mouse button when a heavy black line appears between the 
Address and City field names.

	 11.	 With the Region field selected, hold down the Shift key, and click the City field 
name to include that field in the selection.

	 12.	 In the Sort & Filter group, click the Ascending button.

Access arranges the records with the regions in ascending order and the cities in 
ascending order within each region.
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	 13.	 Experiment with various ways of sorting the records to display different results. 
Then close the Customers table, clicking No when prompted to save the table 
layout.

CLEAN UP  Retain the GardenCompany04 database for use in later exercises.

How Access Sorts

The concept of sorting seems quite intuitive, but sometimes the way Access sorts 
numbers might seem puzzling. In Access, numbers can be treated as either text 
or numerals. Because of the spaces, hyphens, and punctuation typically used in 
street addresses, postal codes, and telephone numbers, the data type of these 
fields is usually Text, and the numbers are sorted the same way as all other text. 
In contrast, numbers in a field assigned the Number or Currency data type are 
sorted as numerals.

When Access sorts text, it sorts first on the first character in the selected field in 
every record, then on the next character, then on the next, and so on—until it runs 
out of characters. When Access sorts numbers, it treats the contents of each field 
as a single value, and sorts the records based on that value. This tactic can result 
in seemingly strange sort orders. For example, sorting the list in the first column of 
the following table as text produces the list in the second column. Sorting the same 
list as numerals produces the list in the third column.

Original Sort as text Sort as numerals
1 1 1
1234 11 3
23 12 4
3 1234 11
11 22 12
22 23 22
12 3 23

4 4 1234

If a field with the Text data type contains numbers, you can sort the field numerically 
by padding the numbers with leading zeros so that all entries are the same length. 
For example, 001, 011, and 101 are sorted correctly even if the numbers are  
defined as text.
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Filtering Information in Tables
Sorting the information in a table organizes it in a logical manner, but you still have the 
entire table to deal with. For locating only the records containing (or not containing) 
specific information, filtering is more effective than sorting. For example, you could 
quickly create a filter to locate only customers who live in Seattle, only items that were 
purchased on January 13, or only orders that were not shipped by standard mail. When 
you filter a table, Access doesn’t remove the records that don’t match the filter; it simply 
hides them.

The Filter commands are available in the Sort & Filter group on the Home tab, on the menu 
displayed when you click the arrow at the right end of a field name, and on the shortcut 
menu displayed when you right-click anywhere in a field’s column. However, not all Filter 
commands are available in all of these places. 

To filter information by multiple criteria, you can apply additional filters to the results of 
the first one. 

Tip  You can filter records while displaying them in a form by using the same commands as 
you do to filter records in a table.

In this exercise, you’ll filter records by using a single criterion and then by using multiple 
criteria.

SET UP  You need the GardenCompany04 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany04 database, and then 
follow the steps.

	 1.	 In the Navigation pane, under Tables, double-click Customers to open the 
Customers table in Datasheet view.

	 2.	 In the City field, click any instance of Vancouver.

	 3.	 On the Home tab, in the Sort & Filter group, click the Selection button, and then 
in the list, click Equals “Vancouver”.

Access displays a small filter icon shaped like a funnel at the right end of the City 
field name to indicate that the table is filtered by that field. The status bar at the 
bottom of the table has changed from 1 of 110 to 1 of 6 because only six records 
have the value Vancouver in the City field. Also on the status bar, the Filter status 
has changed to Filtered.
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Only the six records for customers who live in Vancouver are displayed in the table.

Tip  In the list displayed when you click the arrow to the right of a field name (or the 
Filter button in the Sort & Filter group) are check boxes for all the unique entries in 
the active field. Clearing the Select All check box clears all the boxes, and you can then 
select the check boxes of any values you want to be displayed in the filtered table.

In the Sort & Filter group on the Home tab, the Toggle Filter button is now active. 
You can use this button to quickly turn the applied filter on and off.

	 4.	 In the Sort & Filter group, click the Toggle Filter button.

Access displays all the records. If you click the Toggle Filter button again, the filter 
will be reapplied.

Now let’s display a list of all customers with postal codes starting with 880.

	 5.	 Click the arrow to the right of the PostalCode field name, and point to Text Filters 
in the list.
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A list of criteria appears.

You can specify criteria for the text you want to find.

Tip  The sort and filter options displayed when you click the arrow to the right of a field 
name (or when you click the Filter button in the Sort & Filter group) are determined by 
the data type of the field. The PostalCode field is a Text field to allow for ZIP+4 codes. If 
you display the sort and filter list for a field that is assigned the Number data type, the 
sort and filter list includes Number Filters instead of Text Filters, and different options 
are available.

	 6.	 In the list, click Begins With.

The Custom Filter dialog box opens.

The name of the text box is customized with the field name and the filer you chose.

	 7.	 In the PostalCode begins with box, type 880. Then click OK.

Access filters the table and displays only the records that match your criteria.
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Only the 30 records for customers who live in postal codes starting with 880 are displayed in 
the table.

	 8.	 In the Sort & Filter group, click the Toggle Filter button to remove the filter and 
display all the records.

Now let’s display only the records of the customers who live outside of the United 
States.

	 9.	 In the Country field, right-click any instance of USA, and then click Does Not 
Equal "USA".

Tip  In this case, it is easy to right-click the text you want to base this filter on. If the text 
is buried in a large table, you can quickly locate it by clicking the Find button in the Find 
group on the Home tab, entering the term you want in the Find What box in the Find 
And Replace dialog box, and then clicking Find Next.

Access displays the records of all the customers from countries other than the 
United States (in this case, only Canada).

	 10.	 Remove the filter, and close the Customers table, clicking No when prompted to 
save your changes.

	 11.	 Open the Orders table in Datasheet view.

	 12.	 In the EmployeeID field, right-click Emanuel, Michael, and then click Equals 
“Emanuel, Michael”.

Twenty records are displayed in the filtered table.
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	 13.	 In the OrderDate field, right-click 2/1/2010, and then click On or After 2/1/2010.

Tip  To see a list of the available options for date filters, right-click any cell in the 
OrderDate field, and then point to Date Filters.

You now have a list of the orders customers placed with the selected employee on or 
after the specified date. You could continue to refine the list by filtering on another 
field, or you could sort the results by a field.

	 14.	 Close the Orders table, clicking No when prompted to save the table layout.

CLEAN UP  Retain the GardenCompany04 database for use in later exercises.

Filtering Information by Using Forms
When you want to filter a table based on the information in several fields, the quickest 
method is to use the Filter By Form command, which is available from the Advanced Filter 
Options list in the Sort & Filter group on the Home tab. When you choose this command 
with a table displayed, Access displays a filtering form that resembles a datasheet. Each of 
the cells in the form has an associated list of all the unique values in that field in the under-
lying table.

Using the Filter By Form command with a table.
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For each field, you can select a value from the list or type a value. When you have finished 
defining the values you want to see, you click the Toggle Filter button to display only the 
records that match your selected criteria.

Using Filter By Form on a table that has only a few fields, such as the one shown above, 
is easy. But using it on a table that has a few dozen fields can be cumbersome, and it is 
often simpler to find information in the form version of the table. When you choose the 
Filter By Form command with a form displayed, Access filters the form the same way it 
filters a table.

)

Using the Filter By Form command with a form.

After you have applied the filter, you move between the matched records by clicking the 
buttons on the record navigation bar at the bottom of the form page.

In this exercise, you’ll filter a form by using the Filter By Form command.

SET UP  You need the GardenCompany04 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany04 database, and then 
follow the steps.

	 1.	 In the Navigation pane, under Forms, double-click Customers.

The Customers form opens in Form view.
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	 2.	 On the Home tab, in the Sort & Filter group, click the Advanced Filter Options 
button, and then in the list, click Filter By Form.

The Customers form is replaced by its Filter By Form version, which has two pages: 
Look For and Or. Instead of displaying the information for one record from the 
table, the form now has a blank box for each field.

	 3.	 Click the second text box to the right of the Name label (the box that normally 
displays the customer’s last name), type s*, and then press Enter.

The asterisk is a wildcard that stands for any character or string of characters. Access 
converts your entry to Like “s*”, which is the proper format, called the syntax, for this 
type of criterion.

See Also  For information about wildcards, see the sidebar “Wildcards” following this 
topic.

	 4.	 In the Sort & Filter group, click the Toggle Filter button.

Access displays the first record that has a LastName value starting with S.

The record navigation bar shows that six records match the filter criterion.

	 5.	 Click the Advanced Filter Options button and then click Filter By Form to redisplay 
the filter form.

Your filter criterion is still displayed in the form.

9780735626928_book.indb   113 2/15/11   1:28 PM



114    Chapter 4  Display Data

Tip  No matter what method you use to enter filter criteria, the criteria are saved as a 
form property and are available until they are replaced by other criteria.

	 6.	 Click the second box to the right of the City/State/ZIP label (the box that normally 
displays the state or region), click the arrow that appears, and then in the list, click CA.

You are instructing Access to find and display records that have both a Region 
value of CA and LastName values starting with S.

Only records matching both of the criteria will be displayed.

	 7.	 Click the Toggle Filter button.

Access displays the first of three records that meet the filtering criteria.

	 8.	 Switch back to the filter form, and at the bottom of the form page, click the Or tab.

The criteria you entered on the Look For page are still there, but on this page, all the 
fields are blank so that you can enter alternatives for the same fields.

Tip  When you display the Or page, a second Or tab appears so that you can include a 
third criterion for the same field if you want.

	 9.	 Type s* in the second Name box, and click WA in the list for the second City/
State/ZIP box.

You are instructing Access to find and display records that have either a Region 
value of CA and LastName values starting with S, or a Region value of WA and 
LastName values starting with S.
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	 10.	 Click the Toggle Filter button.

	 11.	 Use the record navigation bar to view the six records in the filtered Customers form.

	 12.	 Click the Toggle Filter button to remove the filter. Then close the form.

CLEAN UP  Retain the GardenCompany04 database for use in the last exercise.

Wildcards

If you want to filter a table to display records containing certain information but you 
aren’t sure of all the characters, or if you want your filter to match variations of a base 
set of characters, you can include wildcard characters in your filter criteria. The most 
common wildcards are:

●	 *  The asterisk represents any number of characters. For example, filtering the 
LastName field on Co* returns records containing Colman and Conroy.

●	 ?  The question mark represents any single alphabetic character. For example, 
filtering the FirstName field on er?? returns records containing Eric and Erma.

●	 #  The number sign represents any single numeric character. For example, 
filtering the ID field on 1## returns any ID from 100 through 199.

Tip  Access supports several other wildcards. For more information, search for wildcards 
in Access Help.

When searching for information in a Text field, you can also use the Contains text 
filter to locate records containing words or character strings.

Locating Information That Matches Multiple Criteria
As long as your filter criteria are fairly simple, filtering is a quick and easy way to narrow 
down the amount of information displayed in a table or to locate information that matches 
what you are looking for. But suppose you need to locate something more complex, such 
as all the orders shipped to Midwestern states between specific dates by either of two 
shippers. When you need to search a single table for records that meet multiple criteria, 
or when the criteria involve complex expressions, you can use the Advanced Filter/Sort 
command, available from the Advanced Filter Options list.

Choosing the Advanced Filter/Sort command displays a design grid where you enter 
filtering criteria. As you’ll see, filters with multiple criteria are actually simple queries.

See Also  For information about queries, see Chapter 8, “Create Queries.”
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In this exercise, you’ll filter a table to display the data for customers located in two states. 
Then you’ll experiment with the design grid to better understand its filtering capabilities.

SET UP  You need the GardenCompany04 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany04 database, and then 
follow the steps.

	 1.	 In the Navigation pane, under Tables, double-click Customers to open the 
Customers table in Datasheet view.

	 2.	 On the Home tab, in the Sort & Filter group, click the Advanced Filter Options 
button, and then in the list, click Advanced Filter/Sort.

The CustomersFilter1 page opens, displaying the Query Designer with the Customers 
field list in the top pane and the design grid in the bottom pane.

Clicking the Advanced Filter/Sort button displays the Query Designer.

	 3.	 In the Customers field list, double-click LastName to copy it to the Field row of 
the first column of the grid.

	 4.	 In the Criteria row of the LastName field, type s*, and then press Enter.

Because you have used the * wildcard, Access changes the criterion to Like “s*”.

	 5.	 In the Customers field list, double-click Region to copy it to the Field row of the 
next available column of the grid.
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	 6.	 In the Criteria row of the Region field, type ca or wa, and then press Enter.

Tip  If you want to find the records for customers who live in California or Oregon, you 
cannot type ca or or, because Access treats or as a reserved word. You must type ca or 
“or” in the Criteria row. Anytime you want to enter a criterion that will be interpreted 
as an instruction rather than a string of characters, enclose the characters in quotation 
marks to achieve the desired results.

Your entry changes to “ca” Or “wa”. The query will now filter the table to display 
the records for only those customers with last names beginning with the letter S 
who live in California or Washington.

The grid with two criteria.

	 7.	 In the Sort & Filter group, click the Toggle Filter button to display only records 
that match the criteria.

Access switches to the Customers table page and displays the filter results.

Six customers with last names beginning with S live in either California or Washington.
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	 8.	 Click the CustomersFilter1 tab to switch to the filter page. 

	 9.	 In the or row of the LastName field, type b*, and then press Enter.

We want to filter the table to display only the records for customers with last 
names beginning with the letter S or B who live in California or Washington.

The design grid with three criteria.

	 10.	 In the Sort & Filter group, click the Toggle Filter button to apply the filter.

On the Customers table page, the result includes records for all customers with 
last names that begin with S or B, but some of the B names live in Montana and 
Oregon.

	 11.	 Click the CustomersFilter1 tab to switch to the filter page, and look carefully at 
the design grid.

The filter first works with the two criteria in the Criteria row and searches for cus-
tomers with names beginning with S who live in California or Washington. Then 
it works with the criteria in the Or row and searches for customers with names 
beginning with B, regardless of where they live. To get the results we want, we 
need to repeat the criterion from the Region field in the Or row.

	 12.	 In the or row of the Region field, type ca or wa, and then press Enter.

	 13.	 Apply the filter.

Access switches to the Customers table page and displays only the records for  
customers with last names beginning with S or B who are located in California  
or Washington.

	 14.	 Close the Customers table, clicking Yes when prompted to save changes to the 
design of the table.

CLEAN UP  Close the GardenCompany04 database.
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Saving Filters as Queries

If a filter takes more than a few minutes to set up and you are likely to want to use 
it again, you might want to save it as a query. Then you can run the query to display 
the filtered results at any time.

To save a filter as a query:

	 1.	 On the Home tab, in the Sort & Filter group, click the Advanced Filter Options 
button and then click Save As Query.

	 2.	 In the Save As Query dialog box, assign the query an appropriate name, and 
then click OK.

See Also  For information about queries, see Chapter 8, “Create Queries.”

Key Points
●	 You can sort a table in either ascending or descending order, based on the values 

in any field (or combination of fields).

●	 You can filter a table so that information containing a combination of characters is 
displayed (or excluded from the display).

●	 You can apply another filter to the results of the previous one to further refine your 
search.

●	 The Filter By Form command filters a table or form based on the information in 
several fields.

●	 You can use the Advanced Filter/Sort command to search a single table for records 
that meet multiple criteria.
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	 5	 Create Simple 
		  Reports
In this chapter, you will learn how to
✔	 Create reports by using a wizard.
✔	 Modify report design.
✔	 Preview and print reports.

Like forms, reports give people easy access to the information stored in a database. 
However, there are several differences between forms and reports, including the following:

●	 Forms are used to enter, view, and edit information. Reports are used only to view 
information.

●	 Forms are usually displayed on-screen. Reports can be previewed on the screen, 
but they are usually printed.

●	 Forms generally provide a detailed look at records and are usually for the people who 
actually work with the database. Reports are often used to group and summarize 
data, and are often for people who don’t work with the database but who use the 
information stored in the database for other business tasks.

Reports usually present summaries of larger bodies of information. For example, your 
database might hold detailed information about thousands of orders. If you want to edit 
those orders or enter new ones, you can do so directly in the table or through a form. 
If you want to summarize those orders to illustrate the rate of growth of the company’s 
sales, you generate a report.

Like a book report or an annual report of a company’s activities, a report created in 
Microsoft Access 2010 is typically used to summarize and organize information to  
express a particular point of view to a specific audience. When you are designing a  
report, it is important to consider the point you are trying to make, the intended  
audience, and the level of information they will need.
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In this chapter, you’ll create a report by using a wizard. After modifying the layout and 
content of the report, you’ll see how it will look when printed.

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice file you’ll use to complete the 
exercises in this chapter is in the Chapter05 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Creating Reports by Using a Wizard
You can divide the content of an Access report into two general categories: information 
derived from records in one or more tables, and everything else. The everything else 
category includes the title, page headers and footers, introductory and explanatory text, 
and any logos and other graphics.

Just as you can create a form that includes all the fields in a table by using the Form 
tool, you can create a report that includes all the fields by using the Report tool, which 
is located in the Reports group on the Create tab. But such a report is merely a prettier 
version of the table, and it does not summarize the data in any meaningful way. You are 
more likely to want to create a report based on only some of the fields, and that is a job 
for the Report wizard.

Tip  In addition to basing a report on a table, you can base it on the datasheet created when 
you run a query. For information about queries, see Chapter 8, “Create Queries.”

The Report wizard leads you through a series of questions and then creates a report based 
on your answers. So the first step in creating a report is to consider the end result you want 
and what information you need to include in the report to achieve that result. After you 
provide that information, the wizard creates a simple report layout and adds a text box 
control and its associated label for each field you specify.

For example, you might want to use a Products table as the basis for a report that groups 
products by category. When you give the grouping instruction to the wizard, it first sorts 
the table based on the category, and then sorts the products in each category. In the 
space at the top of each group (called the group header), the wizard inserts the name of 
the category.

In this exercise, you’ll use the Report wizard to create a simple report that displays an 
alphabetical list of products.
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SET UP  You need the GardenCompany05_start database located in your Chapter05 
practice file folder to complete this exercise. Open the GardenCompany05_start 
database, and save it as GardenCompany05. Then follow the steps.

	 1.	 With All Access Objects displayed in the Navigation pane, under Tables, click 
(don’t double-click) Categories.

	 2.	 On the Create tab, in the Reports group, click the Report button.

Access creates a report based on all the fields in the Categories table, displays the 
report in Layout view, and adds four Report Layout Tools contextual tabs to the 
ribbon.

The default report created by the Report tool.

Troubleshooting  The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.
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	 3.	 This is not the report we want, so close the Categories report, clicking No when 
prompted to save it.

	 4.	 On the Create tab, in the Reports group, click the Report Wizard button.

The Report wizard starts. Because the Categories table is still selected in the 
Navigation pane, that table is specified in the Tables/Queries box and its fields 
are listed in the Available Fields box.

	 5.	 Display the Tables/Queries list, and then click Table: Products.

The Available Fields box now lists the fields in the Products table.

The first page of the Report wizard with the correct table selected.

	 6.	 In the Available Fields list, double-click ProductName, QuantityPerUnit, and 
UnitsInStock to move them to the Selected Fields box.

Tip  Fields appear in a report in the order in which they appear in the Selected Fields list. 
You can save yourself the effort of rearranging the fields in the report by entering them 
in the desired order in the wizard.
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	 7.	 At the bottom of the page, click Next.

The wizard asks whether you want to group the records. When you group by a 
field, the report inserts a group header at the top of each group of records that 
have the same value in that field.

	 8.	 In the field list on the left, double-click ProductName.

In the preview pane on the right, the wizard moves ProductName into the group 
header area to show that records will be grouped by this field.

	 9.	 In the lower-left corner of the page, click Grouping Options.

The Grouping Intervals dialog box opens.

You can refine the grouping specification in this dialog box.

	 10.	 Display the Grouping intervals list, click 1st Letter, and then click OK.

The group header now indicates the grouping interval you have assigned to the 
grouping field.
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The types of grouping intervals available vary depending on the data type of the field by 
which you are grouping records.

	 11.	 Click Next.

The wizard asks how you want to sort and summarize the records.

You can sort by up to four fields, each in ascending or descending order.
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Tip  For any field that contains numeric information, you can click Summary Options 
near the bottom of the wizard page to display the Summary Options dialog box, where 
you can instruct Access to insert a group footer in the report and to display the sum, 
average, minimum, or maximum value for the field. The only numeric field in this report 
is UnitsInStock, and it is not appropriate to summarize that field.

	 12.	 Click the arrow to the right of the 1 box to display a list of fields, and click 
ProductName. Then click Next.

The wizard asks which of three layouts and which orientation you want for this 
report.

The preview on the left shows the effect of the options on the right.

	 13.	 In the Layout area, click each option in turn to see a preview in the report thumbnail 
to the left.

	 14.	 When you have finished exploring, click Outline. 

	 15.	 With Portrait selected in the Orientation area and the Adjust the field width so 
all fields fit on a page check box selected, click Next.

The wizard prompts you to supply a title for the report.
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For ease of use, you should make the title more specific.

	 16.	 In the title box, type Alphabetical List of Products, and then with Preview the 
report selected, click Finish.

Access creates the report and displays it in Print Preview.

The new report in Print Preview.

	 17.	 Page through the nine-page report, noticing how it is arranged. Then close it.

CLEAN UP  Retain the GardenCompany05 database for use in later exercises.
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Modifying Report Design
You can use the Report wizard to get a quick start on a report, but you will frequently want 
to modify the report to get the result you need. As with forms, the report consists of text 
box controls that are bound to the corresponding fields in the underlying table and their 
associated labels. You can add labels, text boxes, images, and other controls, and you can 
format them, either by using commands on the ribbon or by setting their properties in 
the report’s Property Sheet.

Tip  Property Sheets for reports work the same way as those for forms. For information, see 
“Changing the Look of Forms” in Chapter 3, “Create Simple Forms.”

You can adjust the layout and content of reports in either Layout view or Design view. 
For simple adjustments, it is easier to work in Layout view, where you can see the layout 
with live data, making the process more intuitive.

See Also  For information about creating and modifying reports in Design view, see Chapter 9, 
“Create Custom Reports.”

Tip  Automatic error checking identifies common errors in forms and reports and gives you a 
chance to fix them. For example, Access informs you if a report is wider than the page it will 
be printed on. Error checking is turned on by default. If you want to turn it off, display the 
Backstage view, and click Options to open the Access Options dialog box. In the left pane, 
click Object Designers, clear the error-checking check boxes at the bottom of the page, and 
then click OK.

In this exercise, you’ll modify the layout of a report. You’ll then apply a theme, change 
some of the colors, and dress up the text with character formatting. You will also apply 
a simple rule that formats values differently if they meet a specific criterion.

SET UP  You need the GardenCompany05 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany05 database, and then 
follow the steps.

	 1.	 In the Navigation pane, under Reports, right-click the Alphabetical List of 
Products report, and then click Print Preview.

	 2.	 Maximize the program window if it isn’t already maximized, and then point to 
the previewed report page. 

The pointer changes to a magnifying glass with a plus sign in it.
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In Print Preview, the magnifying glass pointer indicates that you can zoom in on the page.

	 3.	 Click the previewed page once to zoom in.

Tip  You can also zoom in and out by dragging the Zoom slider in the lower-right corner 
of the program window. The current zoom level appears to the left of the slider.

Notice that the report has the following design problems:

❍	 Extraneous text

❍	 Spacey arrangement

❍	 Uninviting formatting

To fix these problems, we need to switch to Layout view.

	 4.	 On the View Shortcuts toolbar, click the Layout View button.

Access adds four Report Layout Tools contextual tabs to the ribbon. First let’s work 
with the group header controls.
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	 5.	 On the Design contextual tab, in the Grouping & Totals group, click the Hide 
Details button.

The controls that are bound to fields in the Products table are hidden so that you 
can concentrate on the group header controls.

	 6.	 Below the title, click ProductName by 1s, and press the Delete key.

The label is removed from all the group headers.

	 7.	 Click the control containing A, and drag it to the left edge of the header.

When you release the mouse button, all the corresponding controls move to the 
corresponding location in their own group headers.

Keyboard Shortcut  Hold down the Alt key and press the Arrow keys to move the 
selected control in small increments. When the shadow box is positioned where you 
want it, click away from the control.

See Also  For more information about keyboard shortcuts, see “Keyboard Shortcuts” at 
the end of this book.

	 8.	 Point to the right border of the selected A control, and when the pointer changes 
to a double-headed arrow, drag to the left until the control is just big enough to 
hold its contents.

Again, all the corresponding controls assume the new size.

It is easier to work with the controls in the group header when the report details are hidden.
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	 9.	 With the A control still selected, hold down the Shift key, and in turn, click the 
Product Name, Quantity Per Unit, and Units In Stock label controls to add 
them to the selection.

	 10.	 On the Design tab, in the Tools group, click the Property Sheet button.

The Property Sheet opens.

Because more than one control is selected, the Selection Type of this Property Sheet is 
Multiple Selection.

	 11.	 On the Format page of the Property Sheet, in the Top property box, type 0.25”, 
and press Enter. Then close the Property Sheet.

In the group header, the letter control and label controls are now aligned 0.25 inch 
from the top of the header, and the height of the header has decreased because less 
space is needed to accommodate the controls.
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Now let’s see how the group header looks with its data.

	 12.	 In the Grouping & Totals group, click the Hide Details button to turn it off and 
display the data from the table.

The numbers in the Units In Stock column are right-aligned. Let’s center them.

	 13.	 Click the first text box control under the Units In Stock label, and on the Format 
contextual tab, in the Font group, click the Center button.

Now we’ll add some color and format the text.

	 14.	 On the Design contextual tab, in the Themes group, click the Themes button, and 
in the gallery, click the Austin thumbnail.

Although nothing much appears to change, the report takes on the color scheme 
and font scheme assigned to the selected theme.

	 15.	 Inside the shaded area of the report header, but away from the title, click a blank 
area. On the Format contextual tab, in the Control Formatting group, click the 
Shape Fill button. Then under Theme Colors in the palette, click the third box 
(Light Green, Background 2).

Notice that by default, a row color has been applied to alternate group headers 
and that this coloring confuses rather than clarifies the report structure. Let’s turn 
off this alternate row color.

	 16.	 Click outside the dotted border to the left of the first group header. In the Back-
ground group, click the Alternate Row Color arrow, and at the bottom of the 
palette, click No Color. 

	 17.	 In the Control Formatting group, click the Shape Fill button, and in the palette, 
click a light brown color.

The entire group header is shaded except the alphabet controls (A, B, C, and so on) 
that you moved earlier. If you wanted to shade them as well, you could select one 
of them and repeat step 17 to apply the light brown fill.

	 18.	 Click outside the dotted border to the left of the first row of data in the report, and 
remove the alternate row color of the data rows. Then click the white space above 
the report header to see the result.

Only the backgrounds of the report header and group headers are now colored.
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Removing the alternate row color makes the structure of this report more obvious.

Tip  Above the first object and below the last object of a report in Layout view are 
the only places you can click that don’t select at least one object on the report.

	 19.	 Click any control, and then in the Selection group, click the Select All button.

Keyboard Shortcut  Press Ctrl+A to select all the controls.

	 20.	 In the Font group, click the Font Size arrow, and then click 9.

Tip  It is usually most efficient to change the character formatting of all the controls 
and then adjust the ones you want to be different.

	 21.	 Click the report’s title control, and then use the commands in the Font group 
to make the text 24 points, bold, and dark green.

	 22.	 Select the controls in the group header, and make them bold and dark green.

	 23.	 Scroll down the report, noticing that a few of the values in the Units In Stock 
column are 0.

We want these values to stand out in the report to remind buyers that it is time 
to order more of these products.

	 24.	 Click any control in the Units In Stock column. Then in the Control Formatting 
group, click the Conditional Formatting button.

The Conditional Formatting Rules Manager dialog box opens.

	 25.	 Click New Rule.
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The New Formatting Rule dialog box opens.

You can create rules that compare the current field value to a specific value or to other values 
in the same field.

	 26.	 With Check values in the current record or use an expression selected as the 
rule type, in the Format only cells where the area, click the arrow for the second 
box, and click less than. Then in the third box, type 1.

	 27.	 In the bottom area, click the Bold button, and change the Font color setting to 
red. Then click OK.

In the Conditional Formatting Rules Manager dialog box, the rule is listed in the 
Rule column with the formatting that will be applied to values that meet the rule’s 
criteria in the Format column.

Values that are less than 1 will be bold and red.
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	 28.	 Click OK. Then scroll down the report again, noticing that all the 0 values are 
now bold and red.

	 29.	 Close the report, clicking Yes to save your changes to its design.

CLEAN UP  Retain the GardenCompany05 database for use in the last exercise.

Previewing and Printing Reports
Using Print Preview to preview Access reports is very similar to using this view in other 
Microsoft Office 2010 programs. If you preview your reports carefully, you won’t have 
any major surprises when you print them.

When previewing reports, you will want to pay special attention to how the pages break. 
In a grouped report, you can control whether group headings are allowed to appear at the 
bottom of a page with no data and whether groups are allowed to break across pages.

You can make changes to the setup of your report pages from the Page Setup contex-
tual tab in Layout view or from the tab displayed when you switch to Print Preview. For 
example, you can specify the following:

●	 Paper size

●	 Margins

●	 Orientation

●	 Number of columns

●	 Whether Access should print the report's structural elements or only its data

You can also click the Page Setup button to display the Page Setup dialog box, where you 
can change all these settings in one place, as well as make additional refinements.

When you are ready to print, you click the Print button on the Print Preview tab of the rib-
bon to display the Print dialog box. You can also display the Print page of the Backstage 
view and then print one copy of the report with the default print settings by clicking the 
Quick Print button.

In this exercise, you’ll preview a report, and you’ll specify that groups should not break 
across pages. Then you’ll explore the available page setup and printing options.

SET UP  You need the GardenCompany05 database you worked with in the preceding 
exercise to complete this exercise. Open the GardenCompany05 database, and then 
follow the steps.

	 1.	 In the Navigation pane, right click the Alphabetical List of Products report, and 
then click Print Preview.
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Only the Print Preview tab appears on the ribbon.

	 2.	 On the page navigation bar at the bottom of the window, click the Next Page 
button repeatedly to view each page of this report.

Because of the changes you made to the report in the previous exercise, the report 
is now six pages. Several of the groups start on one page and continue on the next 
page. For readability, let’s fix this layout problem.

The group at the top of this page is a continuation of one that started  
on the previous page.

	 3.	 Switch to Layout view, and then on the Design tab, in the Grouping & Totals 
group, click the Group & Sort button.

The Group, Sort, And Total pane opens at the bottom of the report page.

You can use this pane to quickly add grouping and sorting levels and set related properties.

	 4.	 In the Group, Sort, and Total pane, in the Group on ProductName bar, click More.

9780735626928_book.indb   137 2/15/11   1:28 PM



138    Chapter 5  Create Simple Reports

Access displays additional options.

These are the current grouping settings.

	 5.	 Click the do not keep group together on one page arrow, and in the list, click 
keep whole group together on one page. Then close the Group, Sort, and 
Total pane by clicking the Group & Sort button again.

	 6.	 Switch to Print Preview, and page through the report.

Now none of the groups is broken across pages. However, the report would look 
better with wider top, left, and right margins.

	 7.	 On the Print Preview tab, in the Page Layout group, click the Page Setup button.

The Page Setup dialog box opens.

The Print Options page of the Page Setup dialog box.
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	 8.	 Click the Page tab, and verify that the paper size is Letter.

	 9.	 Return to the Print Options page, and change the Top, Left, and Right margins to 
0.75. Then click OK.

	 10.	 Scroll through the report to see the results.

Although all the data in the report fits on the page, the page number in the footer 
is set too far to the right and is producing extra pages.

	 11.	 Switch to Layout view, scroll down to the bottom of the report, and then scroll to 
the right until you can see the page number.

	 12.	 Click the page number control, and move and resize it so that it aligns approximately 
with the Units In Stock column heading.

	 13.	 Switch to Print Preview, and page through the report.

The report now fits neatly on seven pages.

	 14.	 If you want, print the report by using the same techniques you would use to print 
any database object.

	 15.	 Close the report, clicking Yes to save your changes.

CLEAN UP  Close the GardenCompany05 database.

Key Points
●	 When designing a report, consider the point you are trying to make, the intended 

audience, and the level of detail needed.

●	 You can create a report that displays only some of the fields in a table by using the 
Report wizard. The report can be sorted and grouped to summarize the data in a 
table in a meaningful way.

●	 You can refine a report in Layout view by manipulating its controls and setting 
its properties. You can also format the controls to structure and highlight data.

●	 In Print Preview, you can see how the report will look when printed and make 
adjustments before you print.
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